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Access Unit A 

Getting Started With Access 2003 

Understanding Relational Databases 
data = valuable asset 
need to store, maintain, retrieve, and present vital business data 
 
advantages of using a DBMS: 
• duplicate data is minimized 
• data entry faster and easier 
• information retrieval faster and easier 
• view/sort information multiple ways 
• information is more secure 
• information can be shared 

Learning Database Terminology 
entity (nib) 
 
 
data hierarchy 

byte 
 
 
 
field 
 
 
 
record 
 
 
 
table 
 
 
 
database 
 
 
 
 
creating relationships among tables 

use a common field to connect related data that is stored in different tables 
 
primary key 
 
 
 
foreign key 
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Relational Database Management System (RDBMS) 
use to store data in structured tables, maintain, retrieve and present 
 
we will use Access to: 
• create new database file  
• create new tables 
• add and delete records 
• change field values so they’re up-to-date 
• create queries to manipulate and retrieve data to answer questions 
• sort data 
• create forms 

Working with the Database Window 
Database Window holds 7 types of Access objects: 
• Table  (Unit A, B, E) 

an object that stores data  in rows (records) and columns (fields) 
 
• Query (Units B, F) 

an object that asks a question about table data 
can select data from multiple tables (if they have a common field!) 

 
• Form (Unit C) 

an object you use to enter/change/view data on the screen in custom layout, usually one 
record at a time 

 
• Report 

an object you can use to print data in a custom layout 
 
• Data Access Page 

an object that is a special type of Web page designed for viewing and working with data 
from an Internet or intranet 

 
• Macro 

an object containing a list of actions you want Access to carry out 
 
• Module 

an object that stores Visual Basic programming instructions written to automate, 
customize, and enhance a database 

 
all these objects are stored in a single .MDB  file 

Navigating Records 
Datasheet view 

see the table’s data 
can view, add, edit, delete a table’s records 
rows = records    and    columns = fields 

 
[Tab]  [Crtl]+[End]  [Crtl]+[Home] 
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Entering Records 

New Record button  
record’s row selector  (nib) 

Editing Records 
navigate to existing record and edit the field values so they’re current and up-to-date 

pencil symbol  
 
a record’s data is saved to disk when: (nib) 
• move to another record 
• close the table’s datasheet 
• Record | Save Record 
 

what does the Save button  do? 
[Ctrl]+[‘] 

[Esc] vs. Undo 

Delete Record button  
can’t Undo 

Previewing and Printing a Datasheet 
printing a datasheet is a “quick and dirty” way to print a table’s records 

very few formatting options 
Reports (Unit D) are a more powerful and flexible way to print data from 1 or more 
tables 

 
Print Preview 
Page Setup 

portrait vs. landscape page orientation 

Getting Help 
virtually identical to the other online Help systems we’ve seen before 

Closing a Database and Exiting Access 
how close a table  
how exit Access? 

saves .MDB file to disk 
also closes any open objects (table, form, etc.) 

Printing a Table’s Structure (nib) 
Tools | Analyze | Documenter | click Tables tab | click box to left of table | click OK | click Print 
button in Preview toolbar 

 
 

Our Final exam will be after Access Unit F. 
Use Word to develop an Access crib sheet and update it after each unit. 
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Access Unit B 

Using Tables and Queries 

Organizing Fields 
Planning a Related Tables 

1. determine desired outputs 

2. determine required inputs 

3. identify fields for each table and field data types 
generally data for each entity placed in a separate table  
each field is a characteristic of an entity 

avoid storing values that can be calculated from other fields 
store the smallest, logically meaningful level of data as separate fields 

use a descriptive field name (eg: FirstName) 
spaces are allowed, but not encouraged 

4. identify a primary key for each table  

5. use foreign keys to build one-to-many relationships between tables 

Modifying a Table 
use Design View to see/modify a table’s field structure 

add or remove fields, change field properties 
 
in the unit: 
• added a new field 
• renamed 3 fields 
• removed a Caption 
• moved a field 

Creating a Table 
table = structure + contents 
each record in a table has the same field structure 
 
2 views of a table: 
• Design View 

view the table’s structure 
create or modify the structure of a table and the properties of its fields 

 
• Datasheet View 

view the table’s data 
view, add, delete, edit a table’s records 
by default, a table shows all records and all fields, sorted in primary key sequence 
rows = records  and  columns = fields 

 
use the View button to switch between these views 
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2 main ways to create a new table: 
• Use the Table Wizard 

used in this unit 
builds a table based on an existing sample table  

 

• Build manually in Design view (Unit E) 
Tables tab | New button 
Table Design pane on top and Field Properties pane beneath 

[F6] to navigate between panes 
 
define a table’s structure by specifying each field’s: 

• name 

• data type (see below) 

• description 
where do they appear? 

• properties 
Caption 
Default Value 
Field Size  (Unit E) 
Format (Unit E) 
Input Mask  (Unit E) 
Validation Rule (Unit E) 
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Access’ main data types: (page 371) 

• AutoNumber 
Access automatically supplies the value by incrementing the previous value 
typically used to effortlessly obtain primary key value 

• Text 
for non-numeric text entries 
field size can be set to < 255 bytes (default = 50 bytes) 

• Memo 
for longer, free form text entries, typically sentences or paragraphs 
< 64,000 total width 

• Number 
for numeric fields that are non-monetary 
can be used for calculations 
many different types of Number fields 

• Date/Time  
important in many business applications 
Access can store dates for the years between 100 to 9999 
can be used for calculations 

• Currency 
for storing monetary values 
can be used for calculations 

• Hyperlink 
represents the address of an Internet location or of a file on a specified drive 

• Yes/No (logical) 
presence/absence of an attribute 

• OLE object 
objects from other applications (eg: graphic, Excel spreadsheet, sound clip) 
 
 

In-class practice: create a new table in Design view 
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Formatting a Datasheet 
Format Datasheet toolbar 
Format | Font… to set font and font size 
Format | Datasheet… for gridlines and color 
File | Page Setup… for margins and page orientation 

Understanding Sorting, Filtering, and Finding 
when working in a datasheet you can 

• Sort 
display records in ascending or descending sequence 

• Filter 
temporarily display only the a subset of records that meet your criteria  

• Find 
similar to Word’s 

 

Standard Toolbar buttons  

Sorting Records 
by default, a table’s records are sorted in primary key sequence 
 
data may be easier to interpret if records are displayed sorted by another field(s) 
 
sorting does not physically rearrange the order of the records stored in the table, it only affects 
how the records are displayed 
 

Sort Ascending & Sort Descending buttons  
 
Sorting on More than One Field (Clues to Use, 383) 

can sort by multiple adjacent columns  
 
consider using a second sort field when the primary sort field has duplicate values and you 
want to control how they’re sorted among themselves 
 
primary sort field is left-most of the sorting fields 
 
secondary sort is next sort field to the right, etc. 
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Finding Records 

Find  
similar to Word’s 
better than scanning yourself! 
many options 

Match Case 
Any Part of Field     Whole Field       Beginning of Field 

 
the Find dialog box can be moved out of the way 

 
steps: 
1) click in search field to be searched 
2) click Find button 
3) supply value to find and options 

similar to Word’s 
 
faster and more accurate than scanning yourself! 
 
many options:  Any Part of Field     Whole Field       Beginning of Field 
 
the Find dialog box can be moved out of the way 

 
Replace (nib) 

similar to Word’s 
best suited to changing multiple occurrences of one field value with another 

Filtering a Table 
a set of criteria used to show a subset of the records 

used to narrow the focus to specific records 
 
Access displays only the records that match the criteria you specify 
 
you can filtering when using a table, a query, or a form 
 
a filter acts like a temporary (unsaved) query 
 

Filter By Selection  
immediately creates and applies a filter that shows only the records that have the same 
field value as the selected field 

i.e., exact matches 
 

steps: 
1. select an instance of the value you wish to use as criterion 
2. right click 
3. Filter by Selection 

 
what on-screen feedback indicates that a filter is being applied? 
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Filter By Form  
allows you to specify more than one criterion 
allows you to specify criterion with a range of values 
 
steps: 
1. click Filter By Form button 
2. fill in criteria 
3. click Apply Filter button  

 

Apply Filter button  
only those records meeting the criteria are shown 
 

Remove Filter button  
removes the filter in the active datasheet or form 

Creating a Query 
review: datasheets show all records and all fields in primary key sequence 
 
Select Query (Access has many other types of queries) 

an object used to view, analyze and edit data from one or more tables 
 
Access selects and displays the records meeting your criteria  

more flexible and powerful than a filter 
think of a query as a saved filter 

 
with a Select Query, you can: 
• choose which fields to see − place desired fields onto grid 

• choose which records to see − specify criteria; the key to designing queries 

• make changes to table data 

• sort records more flexibly 

• select data from multiple tables (Unit F) 

• perform calculations involving field data (Unit F) 
 
2 views of a Query (there is another): 
• Design view 

create a new query or modify existing query’s structure 
record selection criteria, which fields to display, sorting options 

 
• Datasheet view 

add/edit/view records 
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Creating a New Query 
method used here: 
1) Click Query object 
2) click New Query using Wizard 
3) select fields 
4) click Finished 

 
Running a Query 

Run query button (nib)  
 
dynaset (nib) 

dynamic view of a set of records selected & sorted as the query specifies 
 
can enter new records, modify records, delete records in the dynaset 

the changes affect underlying tables 

Modifying a Query in Design View 
Field List 

shows the fields available in the table(s) serving as 
the query’s data source 

can drag fields onto the query design grid 

what happened when you double-clicked a field? 

 
Criteria rows 

criteria control which records are selected for processing 

the query selects only those records meeting the criteria  

can specify multiple criteria (here and Unit F) 

AND 

when conditions are placed on the same criteria row, all conditions on that row 
must be true for the record to be selected for the dynaset 

OR 
when conditions appear on different criteria rows, at least one row must be true 
for the record to be selected for dynaset 
each row is evaluated separately from other rows 
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Access Unit C 

Using Forms 

Planning a Form 

• determine the purpose of the form 

• determine the form’s record source 
if form’s data comes from one table, base the form on that table  
if form’s data comes from more than one table, base the form on a query 

• preliminary layout of the form 
a form can be designed to resemble a paper form to facilitate data entry 

• select appropriate types of controls 
label, text box, image, checkbox 

Creating a Form 
Form 

an object you use to view, enter, change, and delete records on-screen in a custom layout, 
usually one record at a time 

 
datasheets are too limited 
 
steps used here to create a new form using the Form Wizard: 
1. Form 
2. Create form using wizard 
3. specify source of data (table or query) 
4. choose fields to include on form 
5. select layout (columnar, tabular, datasheet, etc.) 
6. select style (Clouds, Pattern, Standard, Stone, etc.) 
7. specify title (used as name when form is saved) 
 

record navigation buttons  

Form Basics 
2 main views of a form: 
• Form View 

view, add, delete, edit records 
 
• Design View 

see/change the form’s layout 
can change placement of fields, add/remove fields, graphics, change colors, etc. 

 
Toolbox 

used to add new unbound controls to a form 
 
Field List 

shows fields available in the form’s underlying record 
source (table or query) 
drag a field and drop onto form 

places a bound text box and label 
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3 sections discussed here (ACCESS C-13): 
• Form Header 

appears at the top of the form 
frequently used for logo, company name, command buttons 

 

• Detail 
used to display the data fields for each record in the underlying table or query 

• Form Footer 
appears at the bottom of the form 
frequently used for command buttons, instructions 

 
 
controls 

everything on a form is some type of control 

egs: text box, label, image, checkbox 

each control is placed in a section of the form 
 
3 categories of controls: 
• bound control 

displays field data (i.e., has a field as its Control Source property) 
eg: a text box that displays the contents of the Title field 

• unbound control 
used to decorate the form (not display field values) 
eg: a label that displays the word Title  
eg: a line or rectangle  

• calculated control 
has a formula or expression as its source of data 
eg: text box w/Control Source as =[Retail]-[Wholesale] 
eg: text box w/Control Source as =Date() 

Selecting Multiple Controls 
3 ways to select multiple controls 
• [Shift]+click 
• [Crtl]+click 

•  
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Moving and Resizing Controls 

move handles 
 

sizing handles 
 

index finger pointer 
purpose?  

open hand pointer 
purpose?  

double-headed arrow pointer 
purpose?  

 
how move a selected text box and its associated label together? 
 
how move only the selected text box, but not its associated label? 

Modifying Labels 

Properties button  
opens the Properties sheet 

used to see/change properties 
for the selected object(s) 

 
some properties are common to all 
types of controls, others apply to only 
certain control types 

 
Caption property 

specifies the text displayed in a label control 
on the Format tab 

 
right-aligned caption text in all labels 
 

Inserting an Image 

Image button  
just as in PowerPoint (Insert | Picture | From File…) 
 
opens a dialog box so you can navigate to the file containing the graphic  
 
places an Image control on the form to display a static picture 
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Using Text Boxes for Calculations 
ControlSource property (nib) 

on the Data tab 
used to specify what appears in a 
control (eg: text box or check box) 

 
here: added a new text box control and set 
its Control Source to  =[Retail]-
[Wholesale] 
 
what happened when you changed an 
item’s Retail value? 

 
Format property 

on the Format tab 
use to customize the way a control’s contents are displayed and printed 
several predefined formats (dates, times, numbers); 
can create a custom format eg: mm/dd/yyyy 
here: changed Profit text box’s Format to Currency 

Modifying the Tab Order 
the sequence in which controls receive the focus as 
a user presses [Tab] to navigate the controls on a 
form 
 
View | Tab Order… 

to refine the form’s tab navigation 
sequence 
generally use after moving or adding 
controls 
each form section has its own tab order 

Entering and Editing Records 
use a form to view/enter/edit/delete records 

New Record button  
 

Edit Record (pencil) symbol  
 
Printing a Single Form 

File | Print… | Selected Record(s) | OK 
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Access Unit E 

Modifying the Database Structure 

One to Many Relationships 
the most common type of inter-table relationship 
each record in table A can have many matching records in table B but each record in table B has 
no more than one matching record in table A. 
egs: each Writer can write many Articles, but each Article is written by 1 Writer 
 each Writer can receive many Payments, but each Payment is made to 1 Writer 

implemention: include the primary key of the one table as a foreign key in the many table 

 

Creating One-to-Many Relationships 

Relationships button  
opens the Relationships window 
used to define/view relationships between tables 

drag the primary key from the one table & drop it on the foreign key in many table 
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Enforcing Referential Integrity (CLUES TO USE, E-7) 
each foreign key in the many table must match the primary key of a record in the one table 

no unmatched foreign keys 
 
keeps data in related tables “in synch” by preventing orphaned records 
 
referential integrity issues: 
• when add or edit a record in the many table and specify a value for the foreign key, there 

must already be a record with the same value in the one table’s primary key field 
eg: the WriterID in each Article, must match a writer in the Writer table 

• can’t delete  a record from the one table if any matching records exist in the many table 
eg: can’t delete a Writer record if any Article records exist for that writer 

• can’t change the primary key of a record in the one table if any matching rows exist in the 
many table 

eg: can’t change a Writer’s WriterID if any Articles use that WriterID 

File | Print Relationships 
creates a report object that illustrates the inter-table rela tionships 

Creating Lookup Fields 
sets field properties that allow a user to choose a value from a list 

the listed values are selected from a predefined list or from another table  
 

 

 

 
helps ensure data integrity since the user must pick an item from the list 
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Modifying Text Fields 
Modifying Number and Currency Fields 
Modifying Date/Time Fields 
Modifying Field Validation Properties 

Properties used here: 

• Field Size 
sets the maximum size for data stored in a field 
 
here: changed FieldSize for several text fie lds to 30 
 changed Hours from Long Integer to Byte 

• Input Mask 
makes data entry easier and controls the values a user can enter into a field 
 
here: EmployeeNo field had an Input Mask of 000-00-0000;;_ 

• Decimal Places 

• Description 
text hat appears in the Status Bar when a field has the focus 

• Format 
select from several predefined formats or create a custom format 
 
here: changed Attended field to format of mm/dd/yyyy 

• Validation Rule 
an expression that limits the values that can be entered into a field 
 
is evaluated when user leaves the field 

if the expression evaluates as TRUE, Access will store the value 
if the expression evaluates as FALSE, Access rejects the value and displays 
either the Validation Text message or a standard error message 

 
here: Attended field’s Validation Rule set to >#01/17/2004# 

• Validation Text 
message that is displayed when a user enters a value that violates the Validation Rule  
 
here: Attended field’s Validation Text set to Date must be on or after 01/17/2004 
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Access Unit F 

Creating Multiple Table Queries 

Building Select Queries 
Field List 

shows the fields available in the tables 
serving as the query’s data source 

can drag fields onto query design grid 

what happens when you double-click a 
field in the Field List? 

how can you remove a field from the Design 
Grid? 

Sorting a Query on Multiple Fields 
when no sort fields are specified, records are displayed in primary key sequence 

query results may be easier to interpret if its rows are sorted 
Access allows up to 10 different sort fields 

 
Sort row on query design grid 

Ascending or Descending 
 
leftmost sort field on QBE grid is the primary sort field, any sort field to its right is the secondary 
sort field, etc. 

when do you need to specify a secondary sort field? 

may need to drag fields to new locations on the QBE grid to control sorting 

Setting Comparison Criteria 
criteria control which records are selected for processing 

the query selects only those records that meet the criteria  

dates are enclosed within # # eg: #12/25/2005# 

text is enclosed within double quotes " " eg: "Trollen" 

text fields are not case sensitive (by default) 
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Commonly used types of criteria: (TABLE F-1, ACCESS F-7) 
• Exact Match 

a record’s field value must exactly match the specified criteria value 
eg: ="Fernandez"  in Last field 

 
• Range Of Values 

a record is selected if its field contains a value within the range of the values listed 
eg: > #1/1/2003#  in a HireDate field 
eg: <= 1000  in a CreditLimit field 

 
• Is Null 

a record is selected if its field lacks a value 
eg: Is Null  in EmailAddress field 

 
• Like  and wildcards  

a record’s field value must match specified pattern 
wildcards provide flexibility 

* wildcard represents any sequence of characters, letters or digits 
 
eg: Like "*access*"  in Description field 

Developing AND Criteria 

when 2 or more conditions are placed on the same criteria row, all conditions on that row must 
be true for the record to be selected for the dynaset 

Developing OR Criteria 

when conditions appear on different criteria rows, at least one row must be true for the record to 
be selected for dynaset 
each row is evaluated separately from other rows 

Creating Calculated Fields 
appears in the query results dynaset but is 
not stored in an underlying table  

you don’t need to store the calculated 
result since the query will always calculate 
the current value whenever the query is 
run. 

multi-word field names must appear in 
brackets 

& 
concatenation operator (nib) 
performs string addition 
 
eg: =[LastName] & ", " & [FirstName] 
 


